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Operazioni di base nel display Menu

Premere il pulsante [MENU] per richiamare il display Menu. Il display Menu contiene cinque menu e consente di applicare 
impostazioni relative a Voice, Song, Metronome/Rhythm, Recording e System (impostazioni generali dello strumento). Questa 
sezione descrive le operazioni di base nel display Menu.
Per quanto riportato di seguito, sarà necessario applicare impostazioni aggiuntive prima di aprire il display Menu.

• Per modificare i parametri Voice:
selezionare una Voice. Per modificare le Voice in Dual/Split/Duo, attivare la funzione desiderata.

• Per modificare i parametri Song:
selezionare una Song.

1. Premere diverse volte il pulsante [MENU] per selezionare il menu desiderato.
Premere il pulsante ripetutamente per passare da un menu all'altro. Il nome del menu mostrato nella parte superiore del 
display e l'icona a sinistra indicano il menu selezionato.

2. Utilizzare i pulsanti [u]/[d]/[l]/[r] per selezionare il parametro desiderato.

3. Utilizzare i pulsanti [l]/[r] per modificare l'impostazione o eseguire la procedura.
Per ripristinare l'elemento selezionato al valore predefinito su CLP-885, CLP-875 e CLP-895GP, tenere premuto il pulsante 
[MENU] finché il valore non viene ripristinato. Su CLP-845, CLP-835 e CLP-865GP, premere contemporaneamente i 
pulsanti [<] e [>]. 

4. Per uscire dal display Menu, premere il pulsante [EXIT].

Menu Voice 
(Voce)

pagina 3
Per applicare le impostazioni delle performance su tastiera (funzione del pedale, 
bilanciamento del volume in Dual/Split/Duo, trasposizione e così via) e per 
modificare le Voice.

Menu Song pagina 9
Per applicare le impostazioni di playback delle Song (ripetizione playback, volume, 
trasposizione e così via), per modificare le Song e gestire i relativi file.

Menu Metronome/
Rhythm 
(Metronomo/
Ritmo)

pagina 16
Per regolare il volume del metronomo e del ritmo, impostare l'indicazione tempo 
del metronomo e applicare le impostazioni relative al ritmo.

Menu Recording 
(Registrazione)

pagina 18 Per applicare le impostazioni di registrazione MIDI.

Menu System 
(Sistema)

pagina 20
Per applicare le impostazioni per l'intero strumento (accordatura, suono, 
spegnimento audio, luminosità del display e così via), formattare un'unità flash 
USB ed eseguire il backup delle impostazioni dello strumento.

885 875 895GP 845 835 865GP
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Menu Voice (Voce)

Questo menu consente di modificare o impostare vari parametri relativi alla performance su tastiera, ad esempio i parametri 
Voice. Mentre si suona la tastiera, modificare singolarmente i valori dei parametri per ottenere il suono desiderato. Quando si 
impostano le Voice in Dual, Split o Duo, attivare la funzione desiderata prima di richiamare il menu Voice.

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita

Transpose (Trasposizione) Traspone l'intonazione dell'intera tastiera in modo 
ascendente o discendente per semitoni al fine di 
agevolare l'esecuzione in tonalità complesse e adattare 
facilmente l'intonazione della tastiera a quella di un 
cantante o di altri strumenti. Ad esempio, impostando 
questo parametro su "5", suonando il tasto Do si 
produce l'intonazione Fa. In questo modo è possibile 
suonare la Song in Fa maggiore come se fosse in Do 
maggiore.

NOTA
• Questa impostazione non influisce sul playback della Song. Per 

trasporre il playback della Song, utilizzare il parametro "Transpose" 
nel menu Song (pagina 10).

• Con Audio recording, il suono trasposto viene registrato in base a 
questa impostazione. Con MIDI recording, il valore "Transpose" nel 
menu Song (pagina 10) è trasposto in base a questa impostazione.

• I dati della performance su tastiera vengono trasmessi con i numeri 
delle note trasposte. L'impostazione Transpose non influisce sui 
numeri delle note MIDI ricevuti da un dispositivo MIDI esterno o da 
un computer.

−12 (un'ottava 
discendente) – 0 
(pitch normale) – 
+12 (un'ottava 
ascendente)

0

Piano Setting 
(Impostazioni 
piano)
* Queste 

impostazioni 
riguardano 
esclusivamente le 
Voice di pianoforte 
con effetti VRM.

Lid Position 
(Posizione 
coperchio)

Ricrea le differenze di suono in base al livello di apertura 
del coperchio di un pianoforte a coda virtuale.

Full (Completo), 
Half (Metà),  
Close (Chiuso)

Full (Completo)

VRM Consente di attivare e disattivare l'effetto VRM.

 VRM (Virtual Resonance Modeling)
La funzione VRM (Virtual Resonance Modeling) utilizza una 
sofisticata elaborazione fisica per simulare il reale suono di 
risonanza delle corde prodotto premendo il pedale damper su 
un vero pianoforte o tenendo premuti i tasti. Su un vero 
pianoforte acustico, premendo il pedale damper e suonando 
un tasto, non solo si fa vibrare la corda del tasto premuto, ma 
anche altre corde e la tavola armonica, con un'influenza 
reciproca, creando una risonanza ricca e brillante che applica 
il sustain e si diffonde. La tecnologia VRM integrata nello 
strumento riproduce fedelmente la complicata interazione 
della risonanza delle corde e della tavola armonica 
utilizzando uno strumento musicale virtuale (elaborazione 
fisica) per rendere il suono ancora più simile a quello di un 
pianoforte acustico reale. Poiché la risonanza istantanea 
viene eseguita al momento in base allo stato della tastiera o 
del pedale, è possibile variare espressivamente il suono 
modificando il tempo di pressione dei tasti, nonché il tempo e 
la profondità di pressione del pedale.

Quando la funzione "VRM" è attiva, impostare i 
seguenti parametri in base alle preferenze.

On, Off On

Damper Res.
(Risonanza 
damper)

Determina la profondità dell'effetto  
di risonanza delle corde applicato 
quando si preme il pedale damper 
(pedale destro).

0 – 10 5
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Menu Voice (Voce)
Piano Setting 
(Impostazioni 
piano)
* Queste 

impostazioni 
riguardano 
esclusivamente le 
Voice di pianoforte 
con effetti VRM.

VRM Damper 
Noise 
(Rumore 
damper)

Consente di attivare e disattivare il 
Damper Noise. Questa funzione 
viene disabilitata quando l'opzione 
"Damper Res." è impostata su 0.

 Damper Noise
Il Damper Noise è il suono prodotto da un 
pianoforte acustico quando si preme il 
pedale damper e cambia di tono e di 
volume a seconda della velocità con cui il 
pedale viene premuto. Premendo 
lentamente il pedale damper si ottiene un 
suono più silenzioso quando le testine del 
damper vengono rilasciate dalle corde, 
premendolo con forza si trasmettono le 
vibrazioni alle corde, il che aggiunge un 
suono più basso e intenso.

On, Off On

String Res.
(Risonanza 
delle corde)

Determina la profondità dell'effetto di 
risonanza delle corde applicato quando 
si preme una nota sulla tastiera.

0 – 10 5

Duplex  
Scale Res.
(Risonanza 
della scala 
duplex)

Regola le vibrazioni di risonanza 
dell'effetto Duplex Scale Resonance.

 Duplex Scale (Scala duplex)
La scala duplex è un metodo di incordatura 
per pianoforti che utilizza corde aggiuntive 
non percosse nelle ottave superiori per 
migliorare il tono. Queste corde vibrano per 
risonanza con le altre corde in un 
pianoforte acustico, risuonando con 
armonici e rendendo il suono più intenso, 
brillante e complesso. Se i damper non 
entrano in contatto con le corde, queste 
continueranno a risuonare anche dopo 
aver sollevato le mani dalla tastiera.

0 – 10 5

Body Res.
(Risonanza 
della struttura)

Regola la risonanza delle componenti 
del pianoforte, ossia la tavola 
armonica, i lati, il telaio e così via.

0 – 10 5

Grand Exp.
(Creazione 
modelli 
Grand 
Expression)

Consente di selezionare il tipo di effetto Grand 
Expression Modeling, il quale simula le transizioni 
fisiche del suono di un vero pianoforte. Quando questa 
funzione viene impostata su "Dynamic" (Dinamica), è 
possibile controllare sfumature estremamente sottili 
nella performance e nel suono cambiando l'intensità di 
esecuzione, il tocco o il modo in cui si rilasciano i tasti. 
Quando viene impostata su "Static" (Statica), le 
sfumature sono solitamente fisse.

 Grand Expression Modeling
Su un vero pianoforte acustico, è possibile produrre minimi 
cambiamenti nel suono a seconda del tipo di tocco e rilascio 
applicato con le mani a un tasto. Ad esempio, quando si 
preme un tasto fino in fondo, questo tocca il keybed 
sottostante e il suono raggiunge le corde, subendo una 
leggera modifica. Inoltre, quando il damper viene premuto fino 
alle corde per diminuire l'intensità del suono, quest'ultimo 
viene modificato a seconda della rapidità di rilascio del tasto. 
La tecnologia Grand Expression Modeling ricrea queste sottili 
variazioni del suono dovuti al tocco, consentendo di 
aggiungere accenti, suonando energicamente, o risonanza, 
suonando dolcemente per produrre un suono più espressivo. 
Suonando note in staccato si può udire un suono nitido, 
mentre rilasciando lentamente i tasti è possibile produrre un 
suono prolungato.

Dynamic 
(Dinamica),  
Static (Statica)

Dynamic 
(Dinamica)

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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Menu Voice (Voce)
Reverb (Riverbero) Determina il tipo di riverbero applicato a tutti i suoni, 
incluse la performance su tastiera, il playback delle Song 
e l'immissione di dati MIDI da un dispositivo MIDI esterno.

• Off: nessun effetto.

• Recital Hall: simula il riverbero nitido tipico di una sala di 
medie dimensioni adatta per le performance al pianoforte.

• Concert Hall: simula il riverbero brillante tipico di una 
grande sala per le performance orchestrali.

• Chamber: simula il riverbero elegante tipico di una piccola 
sala adatta alla musica da camera.

• Room: simula il riverbero delicato tipico di un ambiente più 
raccolto, come una stanza o un salotto.

• Cathedral: simula il riverbero solenne tipico di una 
cattedrale di pietra dal soffitto alto.

• Club: simula il riverbero vivace tipico di un jazz club o di un 
piccolo locale.

• Plate: simula il suono brillante tipico delle apparecchiature 
di riverbero vintage utilizzate negli studi di registrazione.

(Vedere colonna a 
sinistra)

(Varia in base 
alla Voice o alla 
combinazione 
di Voice)

Chorus (Coro) Determina il tipo di Chorus applicato a tutti i suoni, incluse 
la performance su tastiera, il playback delle Song e 
l'immissione di dati MIDI da un dispositivo MIDI esterno.

• Off: nessun effetto.

• Chorus: aggiunge un suono ricco e spazioso.

• Celeste: aggiunge un crescendo e un suono spazioso.

• Flanger: aggiunge effetti di crescendo o diminuendo che 
ricordano il suono di aereo a reazione.

(Vedere colonna a 
sinistra)

(Varia in base 
alla Voice o alla 
combinazione 
di Voice)

Voice Edit 
(Modifica 
Voice)

Modificando le impostazioni riportate di seguito, è possibile modificare il suono della Voice selezionata in 
base alle preferenze. 
Quando sono attive le funzioni Dual, Split o Duo, nel display "Voice Edit" vengono visualizzati più nomi di 
Voice. Selezionare e modificare la Voice desiderata. 

• Quando è attiva la funzione Dual: colonna superiore = Voice 1, colonna inferiore = Voice 2

• Quando è attiva la funzione Split: colonna superiore = Voice destra, colonna inferiore = Voice sinistra
• Quando sono attive le funzioni Dual e Split: colonna superiore = Voice 1 destra, colonna centrale = Voice 2 

destra, colonna inferiore = Voice sinistra
• Quando è attiva la funzione Duo: colonna superiore = Voice per il musicista di destra, colonna inferiore = 

Voice per il musicista di sinistra

Octave 
(Ottava)

Traspone l'intonazione della tastiera verso l'alto e il 
basso per ottave.

−2 – 0 (nessuna 
pitch shift) – +2

(Varia in base 
alla Voice o alla 
combinazione 
di Voice)Volume Regola il volume per ogni Voice selezionata. 0 – 127

Reverb 
Depth 
(Profondità di 
riverbero)

Regola la profondità del tipo di riverbero selezionato. 
L'impostazione su 0 non produrrà effetti. 

NOTA
Quando si utilizza contemporaneamente una Voice VRM per diverse 
parti potrebbero prodursi suoni imprevisti. La profondità del riverbero 
per una parte con priorità verrà applicata a tutte le parti. Durante il 
playback di una Song, viene applicata l'impostazione a una parte  
della Song (ordine di priorità: Ch. 1, Ch. 2, fino al Ch. 16), mentre 
l'impostazione per una parte di tastiera viene applicata quando si 
arresta il playback della Song (ordine di priorità: Voice R1, L e R2).

0 – 127

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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Menu Voice (Voce)
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Voice Edit Chorus 
Depth 
(Profondità 
del chorus)

Regola la profondità del tipo di Chorus selezionato. 
L'impostazione su 0 non produrrà effetti.

NOTA
Quando si utilizza contemporaneamente una Voice VRM per diverse 
parti potrebbero prodursi suoni imprevisti. La profondità del riverbero 
per una parte con priorità verrà applicata a tutte le parti. Durante il 
playback di una Song, viene applicata l'impostazione a una parte della 
Song (ordine di priorità: Ch. 1, Ch. 2, fino al Ch. 16), mentre 
l'impostazione per una parte di tastiera viene applicata quando si 
arresta il playback della Song (ordine di priorità: Voice R1, L e R2).

0 – 127 (Varia in base 
alla Voice o alla 
combinazione 
di Voice)

Effect 
(Effetto)

Determina il tipo di effetto. Gli effetti Reverb e Chorus 
vengono applicati all'intero suono, mentre l'effetto 
selezionato viene applicato solo alla voce selezionata. 
Non è possibile applicare effetti alle Voice VRM.
• Off: nessun effetto.

• DelayLCR: delay applicato nelle posizioni sinistra, centrale 
e destra.

• DelayLR: delay applicato nelle posizioni sinistra e destra.

• Echo: delay che simula il ritardo dell'eco.

• CrossDelay: i delay sinistro e destro si incrociano 
alternativamente.

• Symphonic: aggiunge un effetto acustico ricco e profondo.

• Rotary: aggiunge l'effetto di vibrato prodotto da un 
altoparlante rotante.

• Tremolo: il livello di volume cambia con cicli rapidi.

• VibeRotor: aggiunge l'effetto di vibrato prodotto da un vibrafono.

• AutoPan: il suono effettua un movimento pan da sinistra 
verso destra e avanti e indietro.

• Phaser: introduce una variazione periodica della fase, con 
un crescendo del suono.

• AutoWah: introduce una variazione periodica della 
frequenza centrale del filtro wah.

• Distortion: distorce il suono.

(Vedere colonna a 
sinistra)

Rotary Speed 
(Velocità di 
rotazione)

Disponibile esclusivamente quando "Rotary" è selezionato 
come tipo di effetto. Questo parametro determina la 
velocità di rotazione dell'effetto dell'altoparlante rotante.

Fast (Veloce),  
Slow (Lento)

VibeRotor Disponibile esclusivamente quando "VibeRotor" è 
selezionato come tipo di effetto. Questo parametro 
attiva o disattiva l'effetto VibeRotor.

On, Off

VibeRotor 
Speed 
(Velocità 
VibeRotor)

Disponibile esclusivamente quando "VibeRotor" è 
selezionato come tipo di effetto. Questo parametro 
determina la velocità dell'effetto vibrato del vibrafono.

1 – 10

Effect Depth 
(Profondità 
dell'effetto)

Regola la profondità dell'effetto per la Voice selezionata. 
Alcuni tipi di effetto non consentono la regolazione della 
profondità.

1 – 127

Pan Regola la posizione pan stereo per ogni Voice 
selezionata.

L64 (completamente 
a sinistra) – C (al 
centro) – R63 
(completamente a 
destra)

Harmonic 
Cont
(Contenuto 
armonico)

Produce una tonalità "a picco" peculiare aumentando il 
valore di risonanza del filtro.

NOTA
Il contenuto armonico può avere un effetto solo leggermente udibile o 
non essere applicato per alcune Voice.

−64 – +63

Brightness 
(Luminosità)

Regola la luminosità della Voice selezionata. −64 – +63

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita



Menu Voice (Voce)
Elenco delle funzioni dei pedali

In questa sezione è riportato un elenco delle funzioni che possono essere assegnate al pedale sinistro, centrale e destro da 
"Pedal Assign" nel menu Voice. Le funzioni che possono essere assegnate variano a seconda del pedale.

Voice Edit Touch Sens.
(Sensibilità 
al tocco)

Determina in che misura il livello di volume varia in 
risposta al tocco della tastiera. Poiché il livello di 
volume di alcune Voice, ad esempio Harpsichord e 
Organ, non varia indipendentemente dalla pressione 
esercitata sulla tastiera, l'impostazione predefinita di 
queste Voice è 127.

0 (più tenue) –  
64 (modifiche 
massime nel livello) 
– 127 (che produce 
il più intenso a 
prescindere da 
come si suona la 
tastiera)

(Varia in base 
alla Voice o alla 
combinazione 
di Voice)

RPedal 
(Pedale R)

Attiva o disattiva la funzione del pedale destro, centrale 
o sinistro per la Voice selezionata. Questo parametro è 
utile per garantire, ad esempio, che la funzione del 
pedale influisca sulla performance della mano destra 
ma non su quella della mano sinistra quando la 
funzione Split è attiva. 

On, Off

CPedal 
(Pedale C)

LPedal 
(Pedale L)

Pedal Assign 
(Assegnazione 
del pedale)

Right (Destro) Cambia la funzione del pedale destro, centrale o 
sinistro.

NOTA
L'impostazione predefinita del pedale sinistro varia per determinate 
Voice: "Rotary Speed" per la Voice "Jazz Organ 1", "Jazz Organ 2" e 
"Rock Organ", "VibeRotor" per la Voice "Vibraphone".

(Consultare 
l'elenco sottostante 
delle funzioni dei 
pedali)

Sustain (Cont.)

Center 
(Centrale)

Sostenuto

Left (Sinistro) Soft (Sordina)

Balance 
(Bilanciamento)
* Vengono 

visualizzati solo  
i parametri 
disponibili quando 
le funzioni Dual, 
Split o Duo sono 
attive.

Volume  
R2 – R1

Regola il bilanciamento del volume tra due Voice 
quando Dual è attivo. Spostando lo slider verso destra 
si alza il volume di Right 1 e si abbassa quello di Right 
2 e viceversa.

R2+10 – 0 – R1+10 (Varia in base 
alla Voice o alla 
combinazione 
di Voice)

Volume  
L – R

Regola il bilanciamento del volume tra le sezioni destra 
e sinistra quando è attivo Split o Duo. Spostando lo 
slider verso destra si alza il volume della sezione destra 
e si abbassa quello della sezione sinistra e viceversa.

L+10 – 0 – R+10

Detune Effettua il detune alle voci Right 1 e Right 2 in Dual per 
creare un suono più corposo. Spostando lo slider 
verso destra si alza l'intonazione della voce di Right 1 
e si abbassa quella di Right 2 e viceversa.

R2+20 – 0 – 
R1+20

Funzione Descrizione Assegnabile o meno (: Sì, –: No)

Pedale 
sinistro

Pedale 
centrale

Pedale 
destro

Sustain (Switch) Applica il sustain alle note mentre si preme il pedale, anche dopo 
aver sollevato le dita dalla tastiera.

  

Sustain (Cont.) Applica il sustain alle note mentre si preme il pedale, anche dopo aver 
sollevato le dita dalla tastiera. La durata del sustain cambia in base 
all'intensità della pressione esercitata sul pedale.

– – 

Sostenuto Se si suona una nota o un accordo sulla tastiera e si preme il 
pedale tenendo le note, l'effetto sustain persiste fino al rilascio del 
pedale. Le note successive non avranno l'effetto sustain. 

  

Soft Premendo questo pedale si riduce il volume e si modifica 
leggermente il timbro delle note suonate.

  

PitchBend Up Aumenta progressivamente l'intonazione. – – 

PitchBend Down Diminuisce progressivamente l'intonazione. – – 

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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Menu Voice (Voce)
NOTA
• Può essere applicato il sustain al suono di alcune Voice, come gli archi e l'organo, in modo continuo quando viene premuto il pedale a cui è stata assegnata la 

funzione damper/sostenuto.
• Se la funzione [PLAY/PAUSE] (Play/Pausa) viene assegnata a un pedale da "Pedal" > "Play/Pause" nel menu System (pagina 22), la funzione assegnata al pedale 

corrispondente viene disattivata.

Rotary Speed Cambia la velocità dell'altoparlante rotante (per le Voice Jazz 
Organ 1 e 2 e Rock Organ) tra "Fast" e "Slow" ogni volta che si 
preme il pedale.

  

VibeRotor Attiva e disattiva il vibrato, per la Voice Vibraphone, ogni volta che 
si preme il pedale.

  

Funzione Descrizione Assegnabile o meno (: Sì, –: No)

Pedale 
sinistro

Pedale 
centrale

Pedale 
destro
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Menu Song

Questo menu consente di impostare vari parametri relativi al playback delle Song e di modificare i dati delle Song. Selezionare 
una Song prima di iniziare la procedura.
I parametri disponibili differiscono tra Song MIDI e Song audio. I seguenti parametri indicati con "(Audio)" possono essere impostati solo 
dopo aver selezionato una Song audio, quelli indicati con "(MIDI)" dopo aver selezionato una Song MIDI. I parametri "Edit" (Modifica) 
non possono essere impostati per le Song preset e le Song demo delle Voice.

AVVISO
"Execute" (Esegui) è una funzione che modifica i dati della Song corrente. Premendo il pulsante [r] i dati originali vengono sostituiti con i nuovi 
dati. 

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita

Volume
(Audio)

Regola il volume della Song audio selezionata. 0 – 127 100

Repeat (Ripetizione)
(Audio)

Consente di selezionare il tipo di ripetizione del 
playback della Song.
• Off: disattiva la ripetizione del playback. Quando il playback 

della Song selezionata giunge al termine si interrompe 
automaticamente.

• Single (Singola): riproduce ripetutamente solo la Song 
selezionata.

• All (Tutte): riproduce continuamente in ordine numerico tutte 
le Song nella cartella che contiene la Song selezionata.

• Random (Casuale): riproduce continuamente in ordine 
casuale tutte le Song nella cartella che contiene la Song 
selezionata.

Quando si seleziona un tipo di ripetizione diverso da Off, 
viene visualizzata l'icona di stato (Single: , All: 

, Random: ) in alto a destra sul display Song.

Off, Single 
(Singola), All 
(Tutte), Random 
(Casuale)

Off

L / R
(MIDI)

R Attiva (riproduce) o disattiva (esclude) ciascuna traccia 
della Song MIDI selezionata. Per le parti prive di dati, 
viene visualizzato "---" e la parte non può essere 
attivata o disattivata.

NOTA
Una Song MIDI è composta da 16 tracce (parti) e in genere la traccia 1 
è assegnata a "R", la traccia 2 a "L" e le tracce da 3 a 16 a "Extra".

On, Off On

L

Extra

Repeat
(MIDI)

A – B Consente di riprodurre ripetutamente un intervallo 
specificato (dal punto A al punto B) della Song MIDI 
selezionata.

1. Premere il pulsante [PLAY/PAUSE] per avviare il 
playback della Song.

2. Premere il pulsante [r] in corrispondenza del 
punto di inizio (A) dell'intervallo da ripetere.

3. Premere nuovamente il pulsante [r] in 
corrispondenza del punto finale (B). Dopo 
un'introduzione automatica (per guidare il musicista 
nella frase), viene eseguito ripetutamente 
l'intervallo dal punto A al punto B

Per disabilitare la funzione A-B Repeat, premere il 
pulsante [r] nel display A-B Repeat quando è 
selezionato "Repeat Off". Selezionando un'altra Song, 
A-B Repeat viene disabilitata.

NOTA
• Per impostare il punto di inizio (A) della Song, indicare il punto A 

prima di avviare il playback.
• Per specificare il punto finale (B) della Song, riprodurre la Song fino 

alla fine. Il punto B viene impostato automaticamente senza dover 
premere alcun pulsante.

On, Off Off
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Menu Song

0
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Repeat
(MIDI)

Phrase (Frase) Questo parametro può essere impostato solo quando 
è selezionata una Song MIDI che contiene il Phrase 
Mark. È possibile riprodurre ripetutamente una frase 
specificata nella Song. Specificare il numero della 
frase in "Phrase Mark", impostare "Repeat" su "On" e 
avviare il playback della Song. 
Se si riproduce la Song quando "Repeat" è impostato 
su "Off", il numero di Phrase Mark sul display 
progredisce, consentendo di controllare durante 
l'ascolto il numero della frase in riproduzione.
Quando "Repeat" è impostato su "On", l'icona Repeat 
di Phrase Mark ( ) viene visualizzata in alto a 
destra sul display Song.

On, Off Off

Song Consente di selezionare il tipo di ripetizione del 
playback della Song.
• Off: disattiva la ripetizione del playback. Quando il playback 

della Song selezionata giunge al termine si interrompe 
automaticamente.

• Single (Singola): riproduce ripetutamente solo la Song 
selezionata.

• All (Tutte): riproduce continuamente in ordine numerico tutte 
le Song nella cartella che contiene la Song selezionata.

• Random (Casuale): riproduce continuamente in ordine casuale 
tutte le Song nella cartella che contiene la Song selezionata.

Quando si seleziona un tipo di ripetizione diverso da Off, 
viene visualizzata l'icona di stato (Single: , All: , 
Random: ) in alto a destra sul display Song.

Off, Single 
(Singola), All 
(Tutte), Random 
(Casuale)

Off

Volume
(MIDI)

Song – Keyboard 
(Song – Tastiera)

Regola il bilanciamento del volume fra il playback di 
una Song MIDI e la performance su tastiera.

Song+64 – 0 – 
Key+64

0

Song L – R Regola il bilanciamento del volume tra la parte della 
mano destra e la parte della mano sinistra del 
playback di una Song MIDI.

L+64 – 0 – R+64 0

Transpose (Trasposizione) Trasposizione dell'intonazione del playback della Song 
verso l'alto o il basso per semitoni. Ad esempio, 
impostando questo parametro su "5", una Song creata in 
Do maggiore sarà riprodotta in Fa maggiore. Questa 
impostazione non influisce sull'intonazione della tastiera.

NOTA
• L'applicazione della trasposizione a una Song audio può modificarne 

le caratteristiche tonali.
• Il segnale audio in entrata da dispositivi esterni non viene trasposto.
• I dati di playback di una Song MIDI saranno trasmessi con i numeri delle 

note trasposte. L'impostazione Transpose non influisce sui numeri delle 
note MIDI ricevuti da un dispositivo MIDI esterno o da un computer.

Da –12 (un'ottava 
discendente) a  
–0 (pitch 
normale) a +12 
(un'ottava 
ascendente)

0

File Delete (Elimina) Quelle indicate sono procedure relative ai file, come 
l'eliminazione, la copia e lo spostamento delle Song 
salvate nello strumento o nell'unità flash USB 
collegata. Per ulteriori informazioni, consultare 
"Gestione dei file di Song" (pagina 12).

– –

Copy (Copia)
(MIDI)

Move (Sposta)
(MIDI)

MIDI to Audio (Da 
MIDI a Audio)
(MIDI)

Rename 
(Rinomina)

Delete All 
(Elimina tutto)

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita



Menu Song
Edit
(MIDI)

Quantize 
(Quantizzazione)

Consente di allineare la tempistica di ciascuna nota 
nella Song MIDI selezionata. Ad esempio, se si 
registra una frase in 4/4, è possibile che non venga 
eseguita con la massima precisione e che alcune parti 
siano leggermente in anticipo o in ritardo rispetto al 
tempo corretto. Il parametro Quantize può ovviare a 
questo inconveniente. Per ulteriori informazioni, 
consultare "Quantize (allineare il tempo delle note)" 
(pagina 13).

– –

Track Delete 
(Eliminazione 
della traccia)

Consente di eliminare i dati di una traccia specifica 
della Song MIDI selezionata. Per ulteriori informazioni, 
consultare "Track Delete (eliminazione dei dati di una 
traccia specifica)" (pagina 14).

– –

Tempo Change 
(Cambio del 
tempo)

Consente di cambiare il tempo della Song MIDI 
selezionata con il tempo corrente e di sovrascrivere i 
dati. Per ulteriori informazioni, consultare "Tempo 
Change (modificare il valore del tempo)" (pagina 15).

– –

Voice Change 
(Cambio della 
Voice)

Consente di cambiare la Voice di una traccia specifica 
della Song MIDI selezionata con la Voice corrente e di 
sovrascrivere i dati. Per ulteriori informazioni, 
consultare "Voice Change (modificare la Voice di una 
traccia specifica)" (pagina 15).

– –

Others 
(Altri)
(MIDI)

Quick Play 
(Riproduzione 
rapida)

Consente di specificare se una Song che inizia a metà 
battuta, o una Song nella quale la prima nota è 
preceduta da una pausa di silenzio, debba essere 
riprodotta dalla prima nota o dall'inizio della battuta 
(pausa o vuoto). Questo parametro è utile nei casi in 
cui una Song MIDI inizi con un breve conteggio 
introduttivo di uno o due movimenti.

On, Off On

Track Listen 
(Ascolto della 
traccia)

Consente di riprodurre solo una traccia della Song 
MIDI selezionata per ascoltarne il contenuto. 
Selezionare una traccia, spostare l'evidenziatore su 
"Start" e tenere premuto il pulsante [r] per avviare il 
playback dalla prima nota. Il playback continua mentre 
si tiene premuto il pulsante [r].

Track 1 – 
Track 16 (Da 
traccia 1 a 
traccia 16)

Track 1  
(Traccia 1)

Play Track 
(Riproduzione 
delle tracce)

Consente di specificare le tracce della Song MIDI 
selezionata da riprodurre sullo strumento. Se si seleziona 
"1&2", vengono riprodotte solo le tracce 1 e 2, mentre le 
tracce da 3 a 16 vengono trasmesse via MIDI al 
dispositivo collegato. Se si seleziona "All", vengono 
riprodotte tutte le tracce sullo strumento.

All (Tutte), 1&2 All (Tutte)

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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Menu Song
Gestione dei file di Song

I parametri "File" nel menu Song consentono di eliminare una Song, di copiare una Song registrata nello strumento su un'unità 
flash USB o di eseguire procedure relative ai file di Song per gestirli nelle categorie "User" e "USB".

Tipi di Song e limitazioni delle procedure sui file
Nella tabella che segue sono indicati il tipo di Song e le limitazioni delle procedure eseguibili sui file. I tipi di Song sono indicati 
come nome di categoria e icona nel display Song. 

 : Disponibile, –: Non disponibile 

1. Se necessario, collegare un'unità flash USB al terminale USB [TO DEVICE] (Al dispositivo).

2. Selezionare la Song da gestire.

3. Selezionare la procedura desiderata da "File" nel menu Song.

Procedura Descrizione Tipo Song

Categoria Utente USB

Icona

(MIDI) (MIDI) (Audio)

Delete Elimina la Song selezionata.   

Copy Copia o sposta la Song MIDI selezionata su "User" o "USB".
Come per una Song MIDI nella categoria "User" dello strumento, è 
possibile copiare o spostare la Song solo nella cartella "USER FILES"  
su un'unità flash USB. Come per una Song MIDI in un'unità flash USB, è 
possibile copiare o spostare la Song nella categoria "User" dello strumento. 

  –

Move   –

MIDI to Audio Consente di convertire la Song MIDI selezionata in una Song audio 
durante il playback.
Questa operazione, analoga a una registrazione audio, consente di 
registrare le proprie performance su tastiera e altri suoni in entrata 
tramite Bluetooth, jack [AUX IN] e altro ancora.

  –

Rename 
(Rinomina)

Consente di modificare il nome della Song selezionata.   

Delete All Elimina tutte le Song nella cartella che contiene la Song selezionata.
Se si seleziona una Song nella categoria "User", vengono eliminate tutte 
le Song nella cartella. Se si seleziona una Song nella categoria "USB", 
vengono eliminate tutte le Song nella cartella "USER FILES" o nell'unità 
flash USB collegata.

NOTA
Le Song contenute nella cartella "USER FILES" nell'unità flash USB non verranno eliminate.

  

Nome della SongIcona

Nome della categoria

Strumento

Unità flash USB

Utente

Può essere copiata o 
spostata.

Può essere copiata o 
spostata.

Root

Cartella USER 
FILES
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Menu Song
4. Eseguire la procedura selezionata.

• Quando è selezionato "Delete", "Copy", "Move", "MIDI to Audio" o "Delete All":

4-1. Premere il pulsante [r] per richiamare il display delle procedure.

4-2. Premere il pulsante [d] per selezionare "Execute" (Esegui) e premere il pulsante [r] per eseguire la procedura.

AVVISO
• Non spegnere lo strumento né scollegare l'unità flash USB durante l'esecuzione. Ciò potrebbe causare la perdita di tutti i dati.
• Viene visualizzato un messaggio quando è presente una Song con lo stesso nome nella destinazione in cui si desidera copiarla o 

spostarla. Se si seleziona "Overwrite", si perderanno i dati originali della Song.

• Quando è selezionato "Rename":

4-1. Premere il pulsante [r] per richiamare il display delle procedure.

4-2. Modificare il nome di una Song.
Utilizzare i pulsanti [l]/[r] per spostare il cursore (trattino basso) e utilizzare i pulsanti [u]/[d] per modificare il 
carattere nella posizione corrente del cursore. Per eliminare il carattere nella posizione corrente del cursore, premere il 
pulsante [REC].
Il nome di una Song può essere composto da un massimo di 46 caratteri. I caratteri che superano la capacità del 
display e non sono visibili possono essere visualizzati spostando il cursore con i pulsanti [l]/[r].

NOTA
Per informazioni sui tipi di caratteri disponibili per i nomi delle Song, consultare "Utility" > "Language" a pagina 26 del menu System (Sistema).

4-3. Premere il pulsante [MENU] per rinominare la Song.

AVVISO
Non spegnere lo strumento né scollegare l'unità flash USB durante l'esecuzione. Ciò potrebbe causare la perdita di tutti i dati.

Modifica della Song MIDI selezionata

Da "Edit" nel menu Song è possibile modificare i dati della Song MIDI selezionata nella categoria "User" o "USB" e sovrascriverli.

Quantize (allineare il tempo delle note)
Questa funzione consente di allineare il tempo di ciascuna nota nella Song MIDI selezionata. Ad esempio, se si registra la frase 
mostrata in basso, è possibile che non venga eseguita con la massima precisione e che alcune parti siano leggermente in 
anticipo o in ritardo rispetto al tempo corretto. Il parametro Quantize può ovviare a questo inconveniente.

1. Selezionare la Song MIDI da modificare.

2. Selezionare "Edit" > "Quantize" nel menu Song.

3. Impostare il valore "Quantize" sulle note più basse della Song MIDI.

Cursore
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Menu Song
• Impostazioni: • Esempio di quantizzazione di una croma:

Le tre impostazioni del parametro Quantize contrassegnate con un asterisco (*) sono particolarmente utili in quanto consentono di quantizzare contemporaneamente  
i valori di due note diverse. Ad esempio, quando una parte contiene crome semplici e terzine di crome, quantizzando per crome semplici, tutte le note della parte 
vengono regolate sulla durata delle crome semplici, eliminando ogni percezione di terzina. Viceversa, utilizzando l'impostazione per crome + terzine di crome, vengono 
quantizzate correttamente sia le note semplici che le terzine.

4. Impostare il valore "Strength" (Forza) che determina in che misura vengono quantizzate le note.
L'impostazione su 100% produrrà il tempo esatto. Se si seleziona un valore inferiore al 100%, le note verranno spostate 
verso i battiti di quantizzazione specificati in base alla percentuale indicata. Applicare una quantizzazione inferiore al 100% 
consente di mantenere una percezione "naturale" della registrazione.

5. Selezionare "Execute" e premere il pulsante [r] per salvare i dati modificati.
AVVISO
Premendo il pulsante [r] i dati della Song MIDI selezionata verranno sovrascritti. Prestare attenzione per non perdere i dati più importanti.

Track Delete (eliminazione dei dati di una traccia specifica)
Questa funzione consente di eliminare i dati di una traccia specifica della Song MIDI selezionata.

1. Selezionare la Song MIDI da modificare.

2. Selezionare "Edit" > "Track Delete" nel menu Song.

3. Selezionare la traccia desiderata da eliminare in "Track".

Nel display della selezione delle tracce, il segno "*" indica la traccia che contiene i dati. Per controllare i dati registrati, 
riprodurli da "Others" > "Track Listen" nel menu Song (pagina 11).

1/4................

1/8................

1/16.............

1/6................

1/12.............

1/24.............

1/8+1/12.........

1/16+1/24.......

1/32.............

1/16+1/12.......

semiminima

terzina di semiminime

croma

terzina di crome

semicroma

terzina di semicrome

biscroma

croma + terzina di crome*

semicroma + terzina di crome*

semicroma + terzina di semicrome*

Dati originali

Forza di quantizzazione = 100%

Forza di quantizzazione = 50%

Durata di una semiminima
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Menu Song
4. Selezionare "Execute" e premere il pulsante [r] per salvare i dati modificati.
AVVISO
Premendo il pulsante [r] i dati della Song MIDI selezionata verranno sovrascritti. Prestare attenzione per non perdere i dati più importanti.

Tempo Change (modificare il valore del tempo)
Questa funzione consente di modificare il valore del tempo della Song MIDI selezionata e di sovrascrivere i dati.

1. Selezionare la Song MIDI da modificare.

2. Premere il pulsante [TEMPO] per richiamare il display Tempo, quindi impostare il valore del 
tempo desiderato.

3. Selezionare "Edit" > "Tempo Change" nel menu Song.

4. Selezionare "Execute" e premere il pulsante [r] per salvare i dati modificati.
AVVISO
Premendo il pulsante [r] i dati della Song MIDI selezionata verranno sovrascritti. Prestare attenzione per non perdere i dati più importanti.

Voice Change (modificare la Voice di una traccia specifica)
Questa funzione consente di modificare la Voice di una traccia specifica della Song MIDI selezionata.

1. Selezionare la Song MIDI da modificare.

2. Selezionare la Voice desiderata.

3. Selezionare "Edit" > "Voice Change" nel menu Song.

4. Selezionare la traccia desiderata per la modifica della Voice in "Track".

Nel display della selezione delle tracce, il segno "*" indica la traccia che contiene i dati. Per controllare i dati registrati, 
riprodurli da "Others" > "Track Listen" nel menu Song (pagina 11).

5. Selezionare "Execute" e premere il pulsante [r] per salvare i dati modificati.
AVVISO
Premendo il pulsante [r] i dati della Song MIDI selezionata verranno sovrascritti. Prestare attenzione per non perdere i dati più importanti.
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Menu Metronome/Rhythm (Metronomo/Ritmo)

Questo menu consente di impostare i parametri relativi al metronomo e al ritmo, come l'indicazione di tempo del metronomo e i 
parametri relativi al playback del ritmo.

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita

Volume Determina il volume del metronomo o del ritmo. Viene utilizzato per 
regolare il bilanciamento del volume tra la performance su tastiera e il 
playback del metronomo o del ritmo.

0 – 127 82

Bell 
(Campanella)

Determina se il suono della campanella viene riprodotto o meno alla 
prima battuta dell'indicazione di tempo specificata.

On, Off Off

Time Sig.
(Indicazione di 
tempo)

Determina l'indicazione di tempo del metronomo. Per ulteriori 
informazioni, consultare "Impostazione dell'indicazione di tempo e 
del tempo per adattarli alla partitura" (pagina 17).

2/2, 3/2, 1/4, 2/4, 
3/4, 4/4, 5/4, 6/4, 
7/4, 3/8, 6/8, 7/8, 
9/8, 12/8

4/4
(Per le Song 
MIDI, le 
differenze variano 
in base alla Song 
selezionata)

BPM Determina se il tipo di nota dell'indicazione di tempo sul display 
Tempo viene influenzata o meno dall'indicazione di tempo del 
metronomo (Crotchet). Quando è selezionato "Time Sig.", il 
denominatore dell'indicatore di tempo viene visualizzato come tipo di 
nota dell'indicazione del tempo. (La semiminima puntata viene 
visualizzata come tipo di nota dell'indicazione del tempo solo quando 
l'indicazione di tempo è impostata su "6/8", "9/8" o "12/8").

Time Sig., 
Crotchet 
(Semiminima)

Time Sig.

Intro Determina se l'intro viene riprodotto o meno prima dell'avvio del 
pattern ritmico.

NOTA
Durante il playback della Song, non è possibile riprodurre l'intro anche se si avvia il ritmo 
con il parametro impostato su "On".

On, Off On

Ending (Finale) Determina se il finale viene riprodotto o meno prima dell'arresto del 
pattern ritmico.

On, Off On

SyncStart Se impostato su "On", è possibile avviare il playback del ritmo 
premendo qualsiasi nota sulla tastiera.
Quando questa funzione è attiva, premendo il pulsante [RHYTHM] si 
imposta il Synchro start (Avvio sincronizzato) in standby e il pulsante 
[RHYTHM] inizia a lampeggiare. Premendo qualsiasi tasto si avvia il 
playback del ritmo.

On, Off Off

Bass (Basso) Determina se l'accompagnamento automatico del basso per il ritmo è 
attivo o meno.

On, Off On
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Menu Metronome/Rhythm (Metronomo/Ritmo)
Impostazione dell'indicazione di tempo e del tempo per adattarli alla partitura

Impostare l'indicazione di tempo e il tempo per tentare di adattarli allo spartito. Se si imposta "Bell" su "On", la prima battuta 
dell'indicazione di tempo specificata viene enfatizzata dal suono di una campanella.

1. Selezionare l'indicazione di tempo desiderata da "Time Sig." nel menu Metronome/Rhythm.

2. Premere il pulsante [TEMPO] per richiamare il display Tempo.

3. Utilizzare i pulsanti [l]/[r] per impostare il tempo.
Sul display Tempo viene visualizzato "Note type=tempo value". In base all'indicazione di tempo impostato nel punto 1, il tipo 
di nota e gli intervalli di tempo disponibili variano come segue.

NOTA
• Il tipo di nota sarà fisso su semiminima finché il parametro "BPM" nel menu Metronome/Rhythm (pagina 16) è impostato su "Crotchet" indipendentemente 

dall'indicazione di tempo selezionata.
• Se si seleziona una Song, i valori dell'indicazione di tempo e del tempo verranno modificati in base a quelli della Song selezionata.

Indicazione di tempo Tipo di nota 
(Lunghezza di una battuta)

Intervallo delle 
impostazioni

2/2, 3/2 Minima
3 – 250

1/4, 2/4, 3/4, 4/4, 5/4, 6/4, 7/4 Semiminima
5 – 500

6/8, 9/8, 12/8 Semiminima puntata
4 – 332 (solo numeri pari)

3/8, 7/8 Croma
10 – 998 (solo numeri pari), 999

Tempo

Indicazione di tempo

Tipo di nota
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Menu Recording (Registrazione)

Questo menu consente di impostare i parametri dettagliati correlati alla registrazione MIDI. Le impostazioni non saranno applicate 
alla registrazione audio.

Nuova registrazione di una sezione di una Song MIDI

È possibile ripetere la registrazione di una traccia specificata in una registrazione esistente di una Song MIDI. Per ascoltare i dati 
registrati di ciascuna traccia, riprodurli da "Others" > "Track Listen" nel menu Song (pagina 11).

1. Nel menu Recording, impostare i parametri che determinano la modalità di avvio e di arresto 
della registrazione.

• Dati registrati per ogni combinazione delle impostazioni "RecStart" e "RecEnd".

2. Selezionare la Song MIDI da registrare nuovamente.

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] per 
selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita

RecStart (Avvio 
registrazione)

Questi parametri specificano quando avviare o interrompere la 
sovrascrittura dei dati mentre si registra su una Song MIDI esistente. 
Per ulteriori informazioni, consultare "Nuova registrazione di una 
sezione di una Song MIDI" in basso.

Normal 
(Normale), 
KeyOn

Normal 
(Normale)

RecEnd (Fine 
registrazione)

Replace 
(Sostituisci), 
PunchOut

Replace 
(Sostituisci)

RecRhythm 
(Registrazione 
ritmo)

Determina se il playback del ritmo sarà registrato o meno nella 
registrazione MIDI. Se impostato su "On", le parti del ritmo verranno 
registrate sulle tracce da 9 a 11.

On, Off On

RecStart Normal 
(Normale)

I dati già registrati saranno sostituiti con quelli nuovi non appena inizia la registrazione.

KeyOn I dati già registrati saranno mantenuti finché non si preme un tasto e la registrazione 
effettiva inizia non appena si preme un tasto.

RecEnd Replace 
(Sostituisci)

Vengono cancellati anche i dati esistenti dopo il punto in cui si arresta la registrazione.

PunchOut I dati esistenti dopo il punto in cui si arresta la registrazione vengono conservati.

Normal/Replace

Normal/PunchOut

KeyOn/Replace

KeyOn/PunchOut

Inizio sovraregistrazione Termine registrazione

Inizio sovraregistrazione Termine registrazione

Inizio playback dei dati originali
Suonare la tastiera per avviare la 
sovraregistrazione Termine registrazione

Inizio playback dei dati originali
Suonare la tastiera per avviare la 
sovraregistrazione Termine registrazione

Nuovi dati Nessun dato

Nuovi dati Dati originali

Dati originali Nessun dato

Dati originali

Nuovi dati

Nuovi dati Dati originali
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Menu Recording (Registrazione)
3. Specificare il punto di inizio della nuova registrazione.

Utilizzare i pulsanti [l]/[r] per spostare la posizione di playback (numero misura) nel punto desiderato. In alternativa, 
premere il pulsante [PLAY/PAUSE] per avviare il playback, quindi premere di nuovo il pulsante [PLAY/PAUSE] leggermente 
prima del punto desiderato.
Se necessario, selezionare le impostazioni (Voice e altri parametri).

4. Tenere premuto il pulsante [REC] per un secondo per richiamare l'elenco delle Song target di 
registrazione, quindi selezionare di nuovo la Song scelta nel punto 2.

5. Utilizzare i pulsanti [l]/[r] per selezionare la traccia da registrare nuovamente.

6. Suonare la tastiera o premere il pulsante [PLAY/PAUSE] per avviare la registrazione.

7. Per arrestare la registrazione, premere il pulsante [REC].

8. Nel display "Confirm", selezionare "Save" per salvare i dati.
Dopo aver salvato i dati, premere il pulsante [PLAY/PAUSE] per ascoltare la performance registrata.
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Menu System (Sistema)

Questo menu consente di applicare le impostazioni generali all'intero strumento, formattare l'unità flash USB, eseguire il backup 
delle impostazioni e molto altro.

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] 
per selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita

Bluetooth Bluetooth Consente di attivare e disattivare la funzione 
Bluetooth. Attivare il Bluetooth per connettere lo 
strumento a un dispositivo che ne è dotato, ad 
esempio uno smartphone.

NOTA
A seconda del Paese in cui è stato acquistato il prodotto, lo 
strumento potrebbe non essere dotato della funzionalità Bluetooth.

On, Off On

Pairing (Associazione) Questo parametro associa un lettore audio dotato 
di Bluetooth e viene visualizzato quando 
"Bluetooth" è impostato su "On".
Premendo il pulsante [r] lo strumento viene 
messo in standby per l'associazione. Lo stesso 
effetto si ottiene tenendo premuto il pulsante [ ] 
(Bluetooth) sui modelli CLP-885/CLP-875/CLP-
895GP o il pulsante [MENU] sui modelli CLP-845/
CLP-835/CLP-865GP per 3 secondi. Per 
informazioni su come connettere lo strumento a 
un lettore audio dotato di Bluetooth, consultare il 
Manuale di istruzioni.

NOTA
È possibile collegare allo strumento un solo dispositivo smart  
alla volta anche se è possibile associarne fino a 8. Una volta 
completata l'associazione al 9° dispositivo smart, i dati di 
associazione per il dispositivo con la connessione meno recente 
saranno eliminati.

– –

Tuning 
(Accordatura)

Master Tune 
(Accordatura principale)

Consente di eseguire l'accordatura fine 
dell'intonazione dell'intero strumento. Questa 
funzione è utile quando si suona questo strumento 
insieme ad altri strumenti o alla musica di un CD.

NOTA
Queste impostazioni non saranno applicate alle voci  
del kit di batteria o alle Song audio. Inoltre, queste 
impostazioni non saranno registrate su una Song MIDI.

(A3=) da  
414,8 Hz a  
466,8 Hz (con 
incrementi di circa 
0,2 Hz)

(A3=) 440,0 Hz

Scale Tune (Intonazione 
scala)

I pianoforti acustici moderni sono accordati quasi 
esclusivamente in temperamento equabile, che 
suddivide un'ottava in dodici intervalli uguali. Allo 
stesso modo, questo strumento utilizza il 
temperamento equabile, ma può essere modificato 
per suonare in temperamenti storici tipici del 
periodo che va dal XVI al XIX secolo.
• Equal (Temperamento equabile): un'ottava è divisa 

in dodici intervalli uguali. Attualmente questa è la 
scala di accordatura più diffusa per il pianoforte.

• PureMajor (Maggiore pura), PureMinor (Minore 
pura): i tre accordi maggiori che utilizzano queste 
scale, basate su armonici naturali, producono uno 
splendido suono puro.

• Pythag. (Pitagorica): questa scala, studiata dal famoso 
filosofo greco Pitagora, viene generata da una 
successione di quinte giuste, ridotte in una singola 
ottava. Le terze di questa scala sono leggermente 
instabili ma le quarte e le quinte sono adeguate e di 
notevole valore per alcuni casi specifici.

• MeanTone (Mesotonica): questa scala fu creata per 
perfezionare la scala pitagorica e per rendere 
l'intervallo di terza maggiore più "intonato". Era 
largamente diffusa dal XVI al XVIII secolo. Tra gli altri, 
fu utilizzata da Händel.

• Werck. (Werckmeister), Kirnberger: queste scale 
combinano la Mesotonica e la Pitagorica in modi diversi 
e la modulazione cambia totalmente l'effetto delle Song. 
Erano molto utilizzate all'epoca di Bach e Beethoven e 
lo sono ancora oggi, poiché consentono di riprodurre la 
musica di quel periodo sui clavicembali.

Equal, PureMajor 
(Maggiore pura), 
PureMinor (Minore 
pura), Pythag., 
MeanTone 
(Mesotonica), 
Werck., Kirnberger

Equal



Menu System (Sistema)
Tuning Base Note (Nota di base) Quando Scale Tune è impostato su un valore 
diverso da "Equal", è necessario impostare la 
nota di base. Se si cambia la nota di base, 
l'intonazione della tastiera viene trasposta, 
conservando però la relazione di intonazione 
tra le singole note.

C (Do), C (Do)♯,  
D (Re), E (Mi)♭,  
E (Mi), F (Fa),  
F (Fa)♯, G (Sol),  
A (La)♭, A (La),  
B (Si)♭, B (Si)

C (Do)

Keyboard Touch Determina quanto il suono risponde all'intensità 
di esecuzione. 
• Soft 2 (Leggero 2): produce un volume abbastanza 

alto anche con una leggera intensità di esecuzione.
• Soft 1 (Leggero 1): produce un volume alto anche 

applicando una moderata intensità di esecuzione.
• Medium (Medio): sensibilità al tocco standard.
• Hard 1 (Duro 1): occorre una forza moderata per 

produrre un volume alto.
• Hard 2 (Duro 2): richiede una forte pressione sui 

tasti per produrre un volume alto.
• Fixed (Fisso): il volume è fisso al livello impostato in 

"Fixed Velocity" (Velocità fissa), descritta in basso, 
indipendentemente dall'intensità di esecuzione.

NOTA
Le impostazioni non saranno registrate su una Song MIDI né 
trasmesse come messaggi MIDI.

Soft 2  
(Leggero 2),  
Soft 1 
(Leggero 2), 
Medium (Medio), 
Hard 1 (Duro 1), 
Hard 2 (Duro 2), 
Fixed (Fisso)

Medium (Medio)

Fixed Velocity Determina la velocità con cui si suona quando 
"Touch", descritto in alto, è impostato su "Fixed".

NOTA
Le impostazioni non saranno registrate su una Song MIDI né 
trasmesse come messaggi MIDI.

1 – 127 64

Duo Quando è impostato su "On", la tastiera viene 
divisa in due sezioni, consentendo di suonare 
duetti nello stesso intervallo di ottava. Per 
ulteriori informazioni, consultare "Esecuzione 
da parte di due musicisti sullo stesso intervallo 
di ottava (Duo)" (pagina 28).

On, Off Off

– Type 
(Tipo)

Consente di selezionare il bilanciamento del 
volume tra gli altoparlanti sinistro e destro 
quando Duo è attivo.
• Separated (Separato): il suono generato dal 

musicista di sinistra viene emesso dall'altoparlante 
sinistro, quello generato dal musicista di destra 
viene emesso dall'altoparlante destro.

• Balanced (Bilanciato): i suoni generati dai due 
musicisti vengono emessi da entrambi gli 
altoparlanti, con un naturale equilibrio del suono.

NOTA
Quando viene selezionato "Separated", Reverb (pagina 5), 
VRM (pagina 3) e Binaural (pagina 23) vengono disattivati.

Separated 
(Separato), 
Balanced 
(Bilanciato)

Separated 
(Separato)

Split Point (Punto di 
split)

Determina il punto di split (il bordo tra le aree 
della mano destra e sinistra) quando sono attivi 
Split o Duo. Nell'area della mano sinistra è 
incluso il tasto specifico assegnato come punto 
di split.
È possibile impostare il punto di split tenendo 
premuto il pulsante [DUAL/SPLIT] e premendo 
contemporaneamente il tasto che si desidera 
impostare come punto di split con le funzioni Split 
o Duo attive.

A−1 – C7 F♯2 (Split),  
E3 (Duo)

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] 
per selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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Pedal Half Pedal Point (Punto 
di mezzo pedale)

Questo parametro consente di specificare il punto 
di pressione del pedale destro a partire dal quale 
l'effetto assegnato inizia a essere applicato. 
Questa impostazione è valida solo quando la 
funzione "Sustain (Cont.)" descritta a pagina 7 è 
assegnata al pedale destro.

−2 (applicato  
alla minima
pressione) – 0 – 
+4 (applicato  
alla massima 
pressione)

0

Soft Pedal Depth 
(Profondità della 
sordina)

Determina la profondità di applicazione dell'effetto 
sordina. Questo parametro è disponibile solo per 
il pedale a cui è assegnato "Soft" (pagina 7).

1 – 10 5

Pitch Bend Range Determina il Pitch Bend Range prodotto tramite 
il pedale in intervalli di semitoni. Questa 
impostazione è disponibile solo per il pedale a 
cui è assegnato "PitchBend Up" o "PitchBend 
Down" (pagina 7).

NOTA
Per alcune voci, è possibile che le variazioni dell'intonazione 
non corrispondano all'impostazione di questo parametro.

0 – +12 
(premendo il 
pedale, 
l'intonazione viene 
alzata o 
abbassata di  
12 semitoni)

2

Play/Pause Consente di assegnare la funzione del 
pulsante [PLAY/PAUSE] sul pannello di 
controllo al pedale sinistro o al pedale centrale. 
Se si seleziona un valore diverso da "Off", la 
funzione del pedale corrispondente assegnata 
nel menu "Voice" (pagina 7) viene disattivata.

Off, Left, Center Off

Sound 
(Suono)

Brilliance (Brillantezza) Regola la brillantezza complessiva del suono 
dello strumento. Questa impostazione 
generalmente si applica alle Voice della 
tastiera, al playback delle Song e agli audio 
MIDI provenienti da un dispositivo esterno.
• Mellow 1 – 3 (Dolce da 1 a 3): suono basso e 

dolce. Maggiore è il numero, più dolce e rotondo 
diventa il suono.

• Normal (Normale): suono standard.
• Bright 1 – 3 (Brillante da 1 a 3): suono brillante. 

Maggiore è il numero, più brillante risulta il suono.
• User (Utente): apre il display "User", dove è possibile 

creare le proprie impostazioni EQ personalizzate. 
L'EQ 
(Equalizzatore) 
è un elaboratore 
del suono che 
divide lo spettro 
di frequenza in 
più bande, le 
quali possono essere amplificate o tagliate a 
seconda delle necessità per adattare la risposta di 
frequenza complessiva. Lo strumento consente di 
regolare il guadagno per tre bande di frequenza 
(Low/Middle/High). 
• Intervallo delle impostazioni: −6 dB – 0 – +6 dB
• Impostazione predefinita: 0 dB

Mellow 1 – 3 
 (Dolce da 1 a 3), 
Normal (Normale),  
Bright 1 – 3 
(Brillante da 1  
a 3), User (Utente)

Normal 
(Normale)

IAC Consente di attivare o disattivare l'effetto IAC 
(Intelligent Acoustic Control). Lo IAC è una 
funzione che regola e controlla automaticamente 
la qualità del suono in base al volume generale 
dello strumento. Lo IAC è valido solo per l'uscita 
audio degli altoparlanti dello strumento o delle 
cuffie. Anche se il volume è basso, consente di 
ascoltare chiaramente i suoni sia bassi che alti. In 
particolare, con l'utilizzo delle cuffie l'impatto 
sull'udito viene ridotto poiché non è necessario 
aumentare eccessivamente il volume.

On, Off On

– Depth 
(Profondità)

Determina la profondità dello IAC. All'aumentare 
del valore, i suoni sia bassi che alti risulteranno 
più chiari a livelli di volume più ridotti.

−3 – +3 0

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] 
per selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita



Menu System (Sistema)
Sound Binaural (Binaurale) Consente di attivare o disattivare la funzione 
Binaural Sampling (Campionamento 
binaurale). Per le Voice con effetti VRM, 
quando la funzione è attiva e le cuffie sono 
collegate, il suono dello strumento passa al 
suono del campionamento binaurale o al suono 
migliorato con lo Stereophonic Optimizer, 
producendo un suono più realistico.

 Binaural Sampling (solo per le voci 
"CFX Grand" e "Bösendorfer")

Il campionamento binaurale è un metodo che prevede 
l'utilizzo di due speciali microfoni in corrispondenza delle 
orecchie del musicista e che registra il suono di un vero 
pianoforte. Ascoltare in cuffia il suono creato mediante 
questo metodo crea un'esperienza immersiva, come se 
il suono provenisse effettivamente dal pianoforte. 
Quando una delle Voice corrispondenti è selezionata, 
collegando le cuffie si abilita automaticamente il 
campionamento binaurale del suono.

 Stereophonic Optimizer (solo per le 
voci con effetti VRM, tranne "CFX 
Grand" e "Bösendorfer")

Lo Stereophonic Optimizer è un effetto che riproduce la 
distanza naturale del suono, come il suono del 
campionamento binaurale, sebbene si senta nelle 
cuffie. Quando una delle Voice corrispondenti è 
selezionata, collegando le cuffie si abilita 
automaticamente lo Stereophonic Optimizer.

NOTA
• Quando "Utility" > "Speaker" (pagina 25) nel menu System 

è impostato su "On", questa funzione è disattivata anche se 
le cuffie sono collegate.

• Quando Binaural è impostato su "On" e le cuffie sono 
collegate, questi effetti influiscono anche sul suono 
proveniente da altoparlanti esterni connessi ai jack AUX 
OUT o sul suono della registrazione audio e potrebbero 
generare suoni insoliti o innaturali. In questo caso, 
disattivare la funzione.

On, Off On

Volume Limiter 
(Limitazione del volume)

Consente di attivare o disattivare la funzione 
Volume Limiter. Quando è impostata su "On", il 
volume massimo del suono viene limitato per 
evitare un livello eccessivo e viene visualizzata 
l'icona ( ) in basso a destra del display 
Song o del display Voice.

On, Off Off

– Limit Point 
(Punto 
limite)

Determina il volume massimo quando la 
funzione Volume Limiter è attiva. Il valore 
dell'impostazione indica la posizione dello 
slider [VOLUME] (MAX = 100%). Il livello del 
volume non aumenta anche se lo slider viene 
spostato oltre questo punto.

10% – 100% 50%

MIDI MIDI OUT Determina il canale MIDI su cui i messaggi 
MIDI generati dalla performance su tastiera 
saranno trasmessi dal terminale USB [TO 
HOST]. Quando Dual, Split o Duo sono attivi,  
i canali MIDI sono assegnati come segue.
• Performance tramite la Voice destra 1 = n (valore 

impostazione)
• Performance tramite la Voice destra 2 = n +2
• Performance tramite la Voice sinistra = n +1

Ch1 – Ch16, Off 
(non trasmesso)

Ch1

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] 
per selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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MIDI MIDI IN Determina la parte dello strumento che sarà 
controllata da ogni dato del canale dei messaggi 
MIDI provenienti dal terminale USB [TO HOST].
• Song: viene controllata la parte di una Song.
• Keyboard: viene controllata tutta la performance su 

tastiera a prescindere dall'impostazione Dual/Split/Duo.
• R1: viene controllata la performance su tastiera 

tramite la Voice destra 1.
• R2: viene controllata la performance su tastiera 

tramite la Voice destra 2.
• L: viene controllata la performance su tastiera 

tramite la Voice sinistra.
• Off: non viene controllata nessuna parte.

Song, Keyboard, 
R1, R2, L, Off

(Per tutti i 
canali)
Song

Local Control Nello stato "Local Control On", quando si suona 
la tastiera lo strumento produce il suono 
utilizzando il tone generator interno. Nello stato 
"Local Control Off", la tastiera e il tone generator 
non comunicano l'uno con l'altro. Questo significa 
che lo strumento non produce il suono anche se 
si suona la tastiera. I dati della tastiera possono 
comunque essere trasmessi tramite MIDI a un 
dispositivo MIDI o a un computer collegato, il 
quale può produrre il suono. L'impostazione 
"Local Control Off" è utile quando si desidera 
utilizzare i tasti dello strumento per produrre il 
suono solo tramite una sorgente sonora esterna.

On, Off On

Receive Param.
(Parametro di ricezione)

Determina i tipi di messaggi MIDI che possono 
essere ricevuti o riconosciuti dallo strumento.

Tipi di messaggio MIDI:
Note on/off, Control Change, Program Change, Pitch 
Bend, System Exclusive

On, Off (Per tutti i 
messaggi)
On

Transmit Param. 
(Parametro di 
trasmissione)

Determina i tipi di messaggi MIDI che possono 
essere trasmessi dallo strumento.

Tipi di messaggio MIDI:
Note on/off, Control Change, Program Change, Pitch 
Bend, System Real Time, System Exclusive

On, Off (Per tutti i 
messaggi)
On

Initial Setup 
(Configurazione iniziale)

Consente di trasmettere le impostazioni correnti 
dello strumento, come la selezione di una Voice, a 
un dispositivo MIDI o a un computer collegato. 
Prima di iniziare la registrazione delle performance 
su un dispositivo MIDI o su un computer collegato, 
eseguire questa procedura per registrare le 
impostazioni correnti del pannello all'inizio dei dati 
della performance. Consente di visualizzare le 
stesse impostazioni del pannello quando si 
riproduce la performance registrata.
Per utilizzare questa funzione, selezionare 
"Execute" quindi premere il pulsante [r] per 
trasmettere le impostazioni dello strumento 
come messaggi MIDI.

– –

Backup Backup Setting 
(Impostazione di backup)

Consente di impostare se memorizzare o meno 
le impostazioni in seguito allo spegnimento dello 
strumento. Per ulteriori informazioni, consultare 
"Selezione dei parametri da conservare in 
memoria anche dopo lo spegnimento (Backup 
Setting)" (pagina 29).

On, Off "Voice" = Off
"Other" = On

Backup Consente di salvare tutti i dati e le impostazioni 
delle Song utente dello strumento su unità flash 
USB connessa come file di backup (estensione: 
.bup). Per ulteriori informazioni, consultare 
"Salvataggio dei dati di una Song e delle 
impostazioni dello strumento su un'unità flash 
USB (Backup)" (pagina 29).

– –

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] 
per selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita



Menu System (Sistema)
Backup Restore (Ripristino) Consente di caricare un file di backup di 
un'unità flash USB (estensione: .bup) sullo 
strumento e di ripristinare le Song e le 
impostazioni utente. Per ulteriori informazioni, 
consultare "Caricamento nello strumento di un 
file di backup salvato su unità flash USB 
(Restore)" (pagina 30).

– –

Factory Reset (Ripristino 
alle impostazioni di 
fabbrica)

Consente di ripristinare le impostazioni di backup alle 
impostazioni di fabbrica. Per ulteriori informazioni, 
consultare "Ripristino alle impostazioni di fabbrica 
(Factory Reset)" (pagina 30).

– –

Utility Speaker (Altoparlante) Consente di attivare o disattivare gli altoparlanti 
dello strumento.
• Normal (Normale): gli altoparlanti producono il 

suono solo se le cuffie non sono collegate al jack 
[PHONES]. 

• On: il suono degli altoparlanti è sempre attivo.
• Off: il suono degli altoparlanti è disattivato.

NOTA
Quando è impostato su "On", "Binaural" (pagina 23) non è attivo.

Normal (Normale),  
On, Off

Normal 
(Normale)

Audio Loopback 
(Loopback dell'audio)

Determina se il suono dell'ingresso audio dal 
computer o dal dispositivo smart collegato 
viene emesso o meno su un computer o su un 
dispositivo smart insieme alla performance 
eseguita sullo strumento.
Ad esempio, per registrare il suono dell'ingresso 
audio insieme al suono riprodotto sullo strumento 
utilizzando il computer o il dispositivo smart 
collegato, impostare questa opzione su "On". Per 
registrare solo il suono riprodotto sullo strumento 
utilizzando il computer o il dispositivo smart, 
impostare questa opzione su "Off".

NOTA
• In questo manuale, "audio input sound" indica i dati audio 

inseriti nello strumento dai dispositivi esterni collegati con 
uno dei seguenti metodi: funzione Interfaccia audio USB, 
funzione Audio Bluetooth, jack [AUX IN] o Wi-Fi.

• Non è possibile trasmettere il suono a un dispositivo 
collegato tramite Bluetooth o jack [AUX IN].

• Con la registrazione dell'audio su questo strumento, il suono 
dell'ingresso audio da un dispositivo esterno viene registrato 
quando è impostato su "On" e non viene registrato quando è 
impostato su "Off". Tuttavia, quando i dispositivi sono collegati 
tramite Audio Bluetooth o jack [AUX IN], i suoni in ingresso 
vengono sempre registrati a prescindere dall'attivazione o 
dalla disattivazione della funzione Audio Loopback.

On, Off On

Auto Power Off 
(Spegnimento 
automatico)

Consente di impostare il tempo che deve 
trascorrere prima dello spegnimento 
automatico dello strumento tramite la funzione 
Auto Power Off. Per disattivare la funzione Auto 
Power Off, selezionare "Off".
È possibile disattivare la funzione Auto Power 
Off accendendo lo strumento e tenendo 
premuto il tasto più basso della tastiera.

AVVISO
Tutti i dati non salvati verranno persi se l'alimentazione 
si disattiva automaticamente. Assicurarsi di avere 
salvato i dati.

Off, 5, 10, 15, 30, 
60, 120 (minuti)

15

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] 
per selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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Utility USB Properties 
(Proprietà USB)

Mostra la quantità di spazio libero e tutta la 
memoria nell'unità flash USB collegata al 
terminale USB [TO DEVICE]. 

– –

USB Autoload 
(Caricamento 
automatico USB)

Se impostato su "On", è possibile selezionare 
automaticamente la Song salvata nella 
directory principale (visualizzata sul display) non 
appena si collega l'unità flash USB al terminale 
USB [TO DEVICE].

On, Off Off

USB Format 
(Formattazione USB)

Questo metodo consente di formattare o 
inizializzare l'unità flash USB collegata al 
terminale USB [TO DEVICE]. Per avviare la 
formattazione, selezionare "Execute" e 
premere il pulsante [r]. Al termine della 
formattazione viene visualizzato un messaggio 
e lo strumento torna, dopo qualche istante, al 
display Utility.

AVVISO
• La formattazione elimina tutti i dati salvati nell'unità 

flash USB. Salvare i dati importanti su un computer 
o su un altro dispositivo di memorizzazione.

• Non spegnere o scollegare l'unità flash USB 
quando sul display è visualizzato il messaggio 
"Executing". In caso contrario, l'unità flash USB e i 
dati potrebbero danneggiarsi.

– –

Contrast (Contrasto) Consente di regolare il contrasto del display. −8 – +8 0

Touch Panel Sound 
(Suono pannello touch)
(CLP-885/CLP-875/ 
CLP-895GP)

Il pannello di controllo emette un suono di 
conferma quando viene attivato. Questa 
funzione può essere attivata o disattivata qui.

On, Off On

Auto Backlight Off 
(Retroilluminazione 
automatica disattivata)
(CLP-885/CLP-875/ 
CLP-895GP)

Consente di impostare il tempo che intercorre 
fino allo spegnimento del pannello di controllo e 
del display o scegliere di mantenerli attivi a 
tempo indeterminato (impostazione "Off").

Off, 10, 20, 30,  
60 (secondi)

30

Language (Lingua) Determina il tipo di caratteri visualizzati sul 
display per il sistema (indicazione generale 
diversa dal nome della Song) e per la Song 
(nome della Song) singolarmente.

Elenco dei caratteri: 

International 
(Internazionale), 
Japanese 
(Giapponese)

International 
(Internazionale)

Version (Versione) Visualizza il nome del modello e la versione del 
firmware dello strumento.

– –

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] 
per selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita

Quantità di 
memoria

Quantità di 
spazio libero

International (Internazionale)

Japanese (Giapponese)
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Utility Wireless LAN (LAN 
wireless)
* Viene visualizzato solo quando è 

collegato un adattatore LAN 
wireless USB.

Consente di impostare una LAN wireless  
(Wi-Fi). Per ulteriori informazioni, consultare 
pagina 31.

– –

Wireless 
LAN Option 
(Opzione 
LAN  
wireless)
* Viene  

visualizzato 
solo quando 
è collegato 
un adattatore 
LAN wireless 
USB.

Wireless 
LAN Mode 
(Modalità 
LAN  
wireless)

Determina se utilizzare Infrastructure Mode 
(Modalità Infrastruttura) o Accesspoint Mode 
(Modalità Punto di accesso).

Infrastructure 
Mode (Modalità 
Infrastruttura), 
Accesspoint Mode 
(Modalità Punto di 
accesso)

Infrastructure 
Mode (Modalità 
Infrastruttura)

Initialize 
(Inizializza)

Consente di inizializzare le impostazioni della 
LAN wireless. Selezionare "Execute" e premere 
il pulsante [r] per inizializzare le impostazioni.

– –

Detail 
(Dettaglio)

Consente di visualizzare il nome dell'host, 
l'indirizzo MAC e lo stato della rete. È possibile 
modificare il nome dell'host. La modalità di 
immissione dei caratteri è la stessa della 
funzione "Rename" di un file di Song 
(pagina 12).

(Nome host)
Fino a 57 caratteri 
(dimensione 
ridotta) inclusi 
caratteri 
alfanumerici, "_" 
(trattino basso) e 
"-" (trattino).

(Nome host)
CLP-***-xxxxxx 
(ultime 6 cifre 
dell'indirizzo 
MAC)

Procedura:
premere diverse volte il pulsante [MENU] per selezionare il menu Voice, quindi utilizzare i pulsanti [u]/[d]/[l]/[r] 
per selezionare il parametro desiderato e modificare le impostazioni.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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Esecuzione da parte di due musicisti sullo stesso intervallo di ottava (Duo)

Questa funzione consente a due interpreti diversi di suonare lo strumento, uno a destra e l'altro a sinistra. Questa funzione è 
particolarmente utile per esercitarsi con i duetti nello stesso intervallo di ottava.

1. Attivare la funzione Duo in "Keyboard" > "Duo" nel menu System.
Sui modelli CLP-885/CLP-875/CLP-895GP, il pulsante [DUAL/SPLIT] diventa arancione; sui modelli CLP-845/CLP-835/CLP-
865GP, il pulsante [DUAL/SPLIT] si accende. La tastiera viene suddivisa in due sezioni e il tasto Mi3 rappresenta il punto di 
split. Il punto di split si trova nell'area della mano sinistra. 

NOTA
Il punto di split può essere impostato in "Keyboard" > "Split Point" nel menu System (pagina 21).

La funzione del pedale cambia come segue.
• Pedale destro: pedale damper per il musicista di destra

• Pedale centrale: pedale damper per entrambi i musicisti

• Pedale sinistro: pedale damper per il musicista di sinistra

2. Se necessario, premere il pulsante [EXIT] per visualizzare il display Voice, quindi utilizzare i 
pulsanti [l]/[r] o il pulsante [VOICE] per selezionare la Voice desiderata.
Quando la funzione Duo è attiva, la dicitura [Duo] viene visualizzata sul display Voice. Solo una Voice (condivisa) può essere 
selezionata per entrambi i musicisti.

3. Suonare la tastiera.
Per impostazione predefinita, il suono del musicista di sinistra viene emesso dall'altoparlante sinistro, quello del musicista di 
destra dall'altoparlante destro.

NOTA
•  Impostando "Keyboard" > "Duo-Type" nel menu System (pagina 21) su "Balanced", il suono generato da entrambi i musicisti viene emesso da entrambi gli 

altoparlanti, ottenendo un bilanciamento naturale del suono.
• Quando la funzione Duo è attiva, l'effetto VRM (pagina 3) non viene applicato. Impostando "Keyboard" > "Duo-Type" nel menu System (pagina 21) su 

"Separated", gli effetti Reverb (pagina 5) e Binaural (pagina 23) non vengono applicati.

4. Per disattivare la funzione Duo, premere il pulsante [DUAL SPLIT].
NOTA
È anche possibile disattivare la funzione Duo premendo uno qualsiasi dei pulsanti [CFX GRAND], [BOSENDORFER] o [PIANO ROOM], o selezionando "Off" 
sul display indicato nel punto 1.

Punto di split Mi3

Musicista di sinistra

Equivalente a Do3 (Do centrale)Equivalente a Do3 (Do centrale)

Musicista di destra
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Selezione dei parametri da conservare in memoria anche dopo lo spegnimento 
(Backup Setting)

I dati e le impostazioni seguenti (chiamati dati di backup) vengono conservati in memoria anche dopo lo spegnimento. I parametri 
contenuti in " Backup Setting" possono essere configurati in modo che le impostazioni vengano conservate o meno in memoria 
anche dopo lo spegnimento.

1. Richiamare "Backup" > "Backup Setting" nel menu System.

2. Selezionare "On" per conservare i dati o "Off" per non conservarli, per ciascuna "Voice" e 
"Other".

• Parametri contenuti in "Voice":
• Selezione Voice

• Tutti i parametri diversi da "Transpose" nel menu "Voice"

• Parametri contenuti in "Other":
• Menu Song: Repeat, Volume (Song-Keyboard), Volume (Song Audio), Quick Play, Play Track

• Menu Metronome/Rhythm: Volume, Bell, BPM, Intro, Ending, Bass

• Menu System: Tuning, Keyboard (tranne "Duo" e "Duo Type"), Pedal, Sound, MIDI

3. Dopo aver effettuato le impostazioni, premere il pulsante [EXIT] per uscire dal menu System.

Salvataggio dei dati di una Song e delle impostazioni dello strumento su 
un'unità flash USB (Backup)

I dati delle Song salvati nella categoria "User" e le impostazioni dello strumento possono essere memorizzati su un'unità flash 
USB come file di backup (estensione: .bup). Il file di backup può essere caricato sullo strumento tramite la funzione Restore 
(pagina 30) per un utilizzo futuro. Consultare "Backup data" in alto per informazioni sui dati specifici contenuti nel file di backup.

AVVISO
• Se lo stesso file di backup (clp-***.bup) è già stato salvato nell'unità flash USB, il file esistente verrà sovrascritto o sostituito con uno nuovo.
• Questa procedura può richiedere da 1 a 2 minuti. Non spegnere lo strumento finché è visualizzato "Executing". La mancata osservanza può 

danneggiare i dati.

1. Collegare l'unità flash USB al terminale USB [TO DEVICE].

2. Richiamare "Backup" > "Backup" nel menu System.

3. Selezionare "Execute" e premere il pulsante [r] per salvare i dati sull'unità flash USB.
Dopo il salvataggio, verrà visualizzato un messaggio che indica il completamento della procedura.

Dati di backup
• Song MIDI salvate nella categoria "User"
• Le seguenti impostazioni nel menu System

- "Bluetooth" > "Bluetooth" (pagina 20)

- "Keyboard" > "Duo-Type" (pagina 21)

- "Utility" (pagina 25)

- Parametri impostati su "On" in "Backup" > "Backup Setting"
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Caricamento nello strumento di un file di backup salvato su unità flash 
USB (Restore)

Caricando il file di backup (estensione: .bup) salvato nell'unità flash USB, è possibile ripristinare le Song utente e le impostazioni 
dello strumento.

AVVISO
• Se nella cartella "User" dello strumento sono presenti delle Song, verranno eliminate durante la procedura di ripristino. Prima di procedere, 

salvare i dati importanti sull'unità flash USB da "File" > "Move" (pagina 10) nel menu Song.
• Questa procedura può richiedere da 1 a 2 minuti. Non spegnere lo strumento finché è visualizzato "Executing". La mancata osservanza può 

danneggiare i dati.

1. Collegare l'unità flash USB che contiene il file di backup al terminale USB [TO DEVICE].

2. Richiamare "Backup" > "Restore" nel menu System.

3. Selezionare "Execute" e premere il pulsante [r] per caricare i dati sullo strumento.
Viene visualizzato un messaggio che indica il completamento della procedura e lo strumento si riavvia.

Ripristino alle impostazioni di fabbrica (Factory Reset)

La funzione Factory Reset inizializza lo strumento alle impostazioni di fabbrica. Quando viene eseguita la funzione Factory Reset, 
le Song MIDI salvate in "User" e le informazioni di associazione Bluetooth non andranno perse.

AVVISO
Non spegnere lo strumento finché è visualizzato "Executing" sul display. La mancata osservanza può danneggiare i dati.

1. Richiamare "Backup" > "Factory Reset" nel menu System.

2. Selezionare "Execute" e premere il pulsante [r] per avviare l'inizializzazione.
Viene visualizzato un messaggio che indica il completamento della procedura e lo strumento si riavvia.

NOTA
Tutte le Song MIDI salvate in "User" possono essere eliminate tramite "File" > "Delete All" nel menu Song. Per ulteriori informazioni, consultare "Gestione dei file di 
Song" (pagina 12).

Metodo alternativo per eseguire la funzione Factory Reset 
È inoltre possibile ripristinare le impostazioni iniziali di fabbrica con il seguente 
metodo.
Tenendo premuto il tasto più acuto, premere l'interruttore [P] (Standby/On) per 
accendere lo strumento.

Tasto più acuto

Switch [P] (Standby/On)  
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Impostazioni LAN wireless (Wi-Fi)

Per connettere lo strumento a un dispositivo smart tramite LAN wireless (Wi-Fi), è necessario utilizzare l'adattatore LAN wireless 
USB UD-WL01, venduto separatamente.

AVVISO
Non collegare questo prodotto direttamente a reti Wi-Fi e/o a servizi internet pubblici. Avvalersi solo di router con protezione sicura tramite 
password. Consultare il produttore del router per informazioni sulle migliori pratiche di sicurezza.

NOTA
L'adattatore LAN wireless USB (UD-WL01) potrebbe non essere disponibile a seconda del Paese.

1. Collegare l'adattatore LAN wireless USB UD-WL01 al terminale USB [TO DEVICE] dello strumento.

2. Selezionare la modalità di connessione da "Utility" > "Wireless LAN Option" > "Wireless LAN 
Mode" nel menu System.

3. Effettuare le impostazioni da "Utility" > "Wireless LAN" nel menu System.
I parametri visualizzati nel display variano tra "Infrastructure Mode" e "Accesspoint Mode". Per informazioni su Infrastructure 
Mode, consultare il prossimo punto; per Accesspoint Mode, consultare pagina 32.

• Per la modalità Infrastruttura:
dall'elenco "Select Network", selezionare la rete desiderata. Per collegarsi a una rete non presente nell'elenco, selezionare 
l'ultima voce "Other". Dopo aver selezionato "Other", impostare SSID, Security (Sicurezza) e Password e selezionare 
"Connect".

Se necessario, tornare al display "Wireless LAN" ed effettuare le impostazioni in "Detail". In seguito, salvare tramite il 
comando "Save".

Infrastructure Mode 
(Modalità 
Infrastruttura)

Questa modalità utilizza un punto di accesso per lo scambio di dati tra l'adattatore LAN 
wireless USB (UD-WL01) e una rete. È possibile utilizzare questa modalità quando si effettua 
la connessione a un'altra rete mentre un dispositivo smart è collegato allo strumento.

• Se il punto di accesso supporta il WPS:
non è necessario effettuare impostazioni sullo strumento. Premere il pulsante WPS 
sull'adattatore LAN wireless USB per più di tre secondi, quindi premere il pulsante WPS sul 
punto di accesso entro due minuti.
NOTA 
Per informazioni sulla conferma e sulle modifiche delle impostazioni del punto di accesso, consultare il relativo manuale.

• Se il punto di accesso non supporta il WPS (o non si dispone di tale informazione):
dall'elenco delle reti visualizzato sullo strumento, selezionare quella desiderata per la connessione.

Accesspoint Mode 
(Modalità Punto di 
accesso)

Questa modalità consente di collegare direttamente l'adattatore LAN wireless USB e un 
dispositivo smart, senza dover utilizzare un punto di accesso. È possibile utilizzare questa 
modalità quando non è disponibile alcun punto di accesso per la connessione allo strumento, 
oppure quando non è necessario connettersi a un'altra rete mentre un dispositivo smart è 
collegato allo strumento.

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita

Select 
Network 
(Selezione 
rete)

(Reti) Effettua il collegamento a un punto di 
accesso selezionando una rete. Quando 
una rete presenta l'icona di un lucchetto 
( ), per accedere è necessario 
immettere una password. La modalità di 
immissione dei caratteri è la stessa della 
funzione "Rename" di un file di Song 
(pagina 13).

– –
CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Manuale di riferimento 31



Menu System (Sistema)

2
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• Per la modalità Punto di accesso:
Impostare SSID, Security, Password e Channel per ultilizzare lo strumento come punto di accesso. In seguito, salvare 
tramite il comando "Save". 

Select 
Network

Other SSID Consente di impostare l'SSID. La modalità 
di immissione dei caratteri è la stessa della 
funzione "Rename" di un file di Song 
(pagina 13).

Fino a 32 caratteri 
(dimensione 
ridotta), caratteri 
alfanumerici, 
simboli

–

Security Consente di impostare la sicurezza. NONE (Nessuna), 
WEP, WPA2-PSK 
(AES), WPA/
WPA2 mixed PSK 
(WPA/WPA2 
mista, PSK)

NONE

Password Consente di impostare la password. La 
modalità di immissione dei caratteri è la 
stessa della funzione "Rename" di un file 
di Song (pagina 13).

Fino a 64 caratteri 
(dimensione 
ridotta), caratteri 
alfanumerici, 
simboli

–

Connect Consente di connettersi alla rete con le 
impostazioni effettuate nel display "Other".

– –

Detail DHCP Consente di configurare le impostazioni 
dettagliate della LAN wireless. È possibile 
impostare IP Address, Subnet Mask, 
Gateway, DNS Server1, DNS Server2 
quando DHCP è impostato su Off, mentre 
non è possibile impostarli quando DHCP è 
impostato su On. Utilizzare i pulsanti [l]/
[r] per selezionare ciascun ottetto nel 
display di immissione, quindi immettere il 
valore tramite i pulsanti [u]/[d]. Per 
finalizzare l'impostazione, premere il 
pulsante [MENU].

On/Off On

IP Address 
(Indirizzo IP)

0.0.0.0–
255.255.255.255

0.0.0.0

Subnet Mask 
(Maschera di 
sottorete)

0.0.0.0–
255.255.255.255

0.0.0.0

Gateway 0.0.0.0–
255.255.255.255

0.0.0.0

DNS Server 1, 2 
(Server DNS 1 e 2)

0.0.0.0–
255.255.255.255

0.0.0.0

Save Consente di salvare le impostazioni nel 
display "Detail".

– –

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita

SSID Imposta l'SSID come punto di accesso. La modalità 
di immissione dei caratteri è la stessa della funzione 
"Rename" di un file di Song (pagina 13).

Fino a 32 caratteri 
(dimensione ridotta), caratteri 
alfanumerici, simboli

ap-CLP-***-xxxxxx 
(ultime 6 cifre 
dell'indirizzo MAC)

Security Consente di impostare Security come punto di 
accesso.

NONE (Nessuna), WEP, 
WPA2-PSK (AES), WPA/WPA2 
mixed PSK (WPA/WPA2 
mista, PSK)

NONE

Password Consente di impostare Password come punto di 
accesso. La modalità di immissione dei caratteri è 
la stessa della funzione "Rename" di un file di 
Song (pagina 13).

Fino a 64 caratteri 
(dimensione ridotta), caratteri 
alfanumerici, simboli

–

Channel Consente di impostare Channel come punto di 
accesso.

Varia a seconda dei modelli di 
adattatore LAN wireless USB.
• Modelli per Stati Uniti e 

Canada: 1–11
• Altri: 1–13
Quando non è collegato un 
adattatore LAN wireless USB, 
l'intervallo delle impostazioni 
include i canali 1–13.

11

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita



Menu System (Sistema)
DHCP 
Server 
(Server 
DHCP)

Consente di effettuare le impostazioni collegate 
all'IP address.

On, Off On

IP Address 192. 168. 0–255. 1–254. 192.168.0.1

Subnet 
Mask

255.255.0.0,
255.255.128.0,
255.255.192.0,
255.255.224.0,
255.255.240.0,
255.255.248.0,
255.255.252.0,
255.255.254.0,
255.255.255.0

255.255.255.0

Save Consente di salvare le impostazioni configurate 
nel display "Wireless LAN" (in modalità Punto di 
accesso).

– –

Parametro Descrizione Intervallo delle 
impostazioni

Impostazione 
predefinita
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